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Introduction

Introduction

This guide explains how to install Cisco Telemetry Broker (at times referred to as CTB in
this document). It describes the Cisco Telemetry Broker components and how they are
placed within your network.

Cisco Telemetry Broker enables you to do the following:

Install Cisco Telemetry Broker

Update Cisco Telemetry Broker

Configure destinations and connections

Migrate from Secure Network Analytics UDP Director
Check the unreachability of a destination

Use IPv4 or IPv6 destinations

Pass through NIC for 10 Gbps throughput

Use high availability

This guide is designed for the person responsible for maintaining network telemetry flow
and monitoring network telemetry.

If you want to install physical broker nodes, follow the instructions in the Cisco Telemetry
Broker Hardware Appliance Installation and Configuration Guide.

The following abbreviations appear in this guide:

Abbreviation Description

DNS Domain Name Server/Service

Gbps Gigabits per second

GB Gigabyte

HTTPS Hypertext Transfer Protocol (Secure)
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Abbreviation

NAT

NIC

NTP

SSH

UDPD

URL

VLAN

VM

Description

Network Address Translation
Network Interface Card
Network Time Protocol
Secure Shell

UDP Director

Universal Resource Locator
Virtual Local Area Network

Virtual Machine
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Concepts and Architecture

Concepts and Architecture

Cisco Telemetry Broker allows you to ingest network telemetry from many inputs,
transform the telemetry format, and forward that telemetry to one or multiple destinations.
Refer to the following table for examples.

Currently, the only hardware appliance that exists for Cisco Telemetry Broker is a
broker node (TB2300). This must be paired with a VM Manager node for
deployment.

0 You can deploy a combination of both virtual and physical broker nodes, or you
can deploy only all virtual broker nodes or only all physical broker nodes.

There is no required order of installation for broker nodes, even if you are
deploying a combination of virtual and physical broker nodes.

You can ingest any of the following And forward that telemetry to any or all
telemetry: of the following destinations:

» Analytics platforms, such as Secure

* On-premises network telemetry, Network Analytics or Secure Cloud
including NetFlow, syslog, and IPFIX Analytics

» Cloud-based telemetry inputs, such * Network management and
as Amazon Web Services (AWS) automation platforms, such as Cisco
Virtual Private Cloud (VPC) Flow DNA Center
Logs » Security Information and Event

Management (SIEM) platforms

To accomplish this, you deploy one or more Cisco Telemetry Broker nodes, which ingest
telemetry and forward it to the configured destinations.

Out of the box, Cisco Telemetry Broker supports the following transformations:

Ingested Data Format Forwarded Data Format
VPC Flow Logs IPFIX
Microsoft Network Security Group IPFIX
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Concepts and Architecture

(NSG) Flow Logs

IPFIX, NetFlow v5, NetFlow v9 JSON (only to SCA destinations)

Your broker nodes are all managed by one Cisco Telemetry Broker Manager. You can log
in to this Manager's web interface and perform various configuration tasks, including

managing the broker nodes, setting up the forwarding connections, creating users, and
reviewing the dashboard for usage.

You deploy these broker nodes and Manager as virtual appliances on a hypervisor.
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Deployment Requirements

Deployment Requirements

The following lists the prerequisites and recommendations for deploying Cisco Telemetry
Broker to your network to forward telemetry from a given input to a destination.

Cisco Telemetry Broker supports the following browsers (as tested with the latest rapid
release and with resolution at 1024 x 768 px):

» Google Chrome
» Microsoft Edge

¢ Mozilla Firefox

For IPv6 systems only: When you upgrade to v2.1.3, you might see that the broker node
update process has not finished. If you check your certificate details in your Cisco
Telemetry Broker system, you will see that the Subject name is [<ipv6_address>].

Complete the following steps as a workaround:

1. Generate a new certificate without the surrounding brackets and upload the new
certificate.

2. On the broker node shell, run ctb-manage and choose Option c (re-fetch the
manager's certificate but keep all other information).

The broker node status will show that the process has finished.

* You cannot register a broker node older than v2.1.3 to a manager node
0 thatis v2.1.3 or newer.

e You cannot register a v2.1.3 or newer broker node with a manager node
older thanv2.1.3

You must do the following before deployment:

 Download two OVA files and create a minimum of two virtual machines.

» Reserve one IP address for the Manager node and two IP addresses for each broker
node you deploy.
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Networks

Management Network: Every node (Manager or broker) in your deployment must have
one network interface (IPv4 or IPv6) connected to the Management Network to provide
for administration over SSH and HTTPS (if the node is running the management
functions).

Telemetry Network: The broker node must have a second interface (IPv4 or IPv6) that
must be connected to the Telemetry Network. On this network the node will receive
telemetry from inputs and forward it to destinations.

The Management Network and the Telemetry Network can be the same network.

Management Network Connection Configuration

Before installing Cisco Telemetry Broker, determine the following settings for the
Management Network:

e |Pv4 or IPv6 address
» |Pv4 or IPv6 subnet prefix length
» |Pv4 or IPv6 default gateway address

e |Pv4 or IPv6 DNS nameserver

You can configure the interface to be active on both an IPv4 and IPv6 address
simultaneously.

Telemetry Network Connection Configuration

Before installing Cisco Telemetry Broker, determine the following settings for the
Telemetry Network:

e |IPv4 or IPv6 address
e |Pv4 or IPv6 subnet prefix length

» |Pv4 or IPv6 default gateway address

You can configure the interface to be active on both an IPv4 and IPv6 address
simultaneously.

For KVM deployments, telemetry brokering uses only 2 CPUs on the broker
0 node. Assigning additional CPUs improves the performance only if the broker
node is performing telemetry transformation.
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Hardware Configuration

You can deploy a broker node using any one of the following three different performance
profiles, depending on the performance type you want to achieve:

» 1 Gbit/s Use this profile to achieve line-rate packet brokering for a 1 Gbit/s NIC.
* 10 Gbit/s Use this profile to achieve line-rate packet brokering for a 10 Gbit/s NIC.

» Transformation Capable Use this profile to achieve telemetry transformation (for
example, sending IPFIX to Secure Cloud Analytics).

Configuration = Manager Broker

1 Gbit/s: 2
10 Gbit/s: 5

Transformation Capable: 8

CPU 4

1 GBit/s: 12 GB
10 GBit/s: 12 GB

Transformation Capable: 12
GB

Memory 8GB

Storage 80GB 70 GB

The broker uses CPUs according to the information described in the following table. Use
this table as a reference to understand how different CPU allocations help to achieve the
desired performance type.

CPUs 1 Gbit/s 10 Gbit/s Transformation Capable
1 Degraded Degraded Degraded
2 Supported Degraded Degraded
3 Supported Degraded Degraded
4 Supported Degraded Degraded
5 Supported Supported Degraded

© 2024 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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6 Supported Supported Degraded
7 Supported Supported Degraded
8 Supported Supported Supported
VMWare ESXi
Resource Manager Broker

Network Interface #1 Connection to

Management Network e1000e €1000e

Network Interface #2 Connection to

Not installed vmxnext
Telemetry Network

We recommend that you use the OVA defaults for all other values. To deploy ctb v1.4+
(which supports the IOMMU feature), ESXi needs to be v6.7+.

KVM QEMU
Resource Manager Broker
Disk virtio-scsi virtio-scsi

Network Interface #1 Connection to

virtio virtio
Management Network

Network Interface #2 Connection to

Not installed virtio
Telemetry Network

Time Synchronization

The Cisco Telemetry Broker VM synchronizes its system time with the hypervisor. To
ensure that features like TLS work correctly, hypervisor time needs to be accurate.

VMWare ESXi

To learn how to run NTP on the ESXi hypervisor, refer to this VMWare knowledge base
article.
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KVM QEMU

To ensure that the hypervisor and the guest are synced, confirm that you have defined the
track="guest’ attribute for the guest machine 's XML configuration as shown in the
following image. For more information, referto 1ibvirt documentation.

<clock offset="utc'>
<timer name='rtc' tickpolicy="catchup' track="guest'/>
<timer name='pit' tickpolicy='delay'/>
<timer name='hpet' present='no'/>

</clock>

This will synchronize the guest clock to the host clock value. However, you need to
accurately maintain the hypervisor host clock. To accomplish this, you can use an NTP
daemon.

By default, Cisco Telemetry Broker VM images are configured to run 1 CPU per socket.
For example, in the image below, CPU Topology shows 1 CPU core per socket on 5
CPU sockets for the total number of 5 CPUs allocated to the VM.

CTB Broker Mode - Deployment Test on QEMU/KVM: 10.0.81.9 B =@ &

File Virtual Machine View SendKey
- o » noe - @ 7

L overview Details XML
L___L 0s information

— CPUs
- Performance Logical host CPUs: 56
vCPU allocation: 5 -
== Memory
@), Boot options Configuration
a SCSI Disk 1 Copy host CPU configuration
ot NIC:bo:8s:TC Model:  Broadwell-IBRS -
o S
‘5} NIC:57:95:55 Enable available CPU security Flaw mitigations
B Tablet
I ~ Topology
L Mouse Manually set CPU topology
=5 Keyboard
() oisplay vne ;
sound iche Cores
,_;g Serial 1

= channel gemu-ga

te> Channelspice

() videooxi

B controllerusso

[ controllersata o

H Controller PCle 0

H Controller VirtlO Serial 0
B8 controller virtioscsio
@ USB Redirector 1

@ usBRedirector2

Q RNG /devfurandom

Add Hardware Cancel Apply
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If you have an issue regarding a clock skew in your VMs, we recommend that you change
the CPU topology to run all CPUs on 1 socket.

=0 »

L__L Overview
D_, OS information

BB rerformance
= Memory
Q Boot Options
®) scsipisk 1
Jt Nic:bo:ss:Te
St NicioTesiss
B Tablet
Mouse

C] Display VNC

sound ich9

= serial1

te Channel gemu-ga

= Channel spice

) video QxL

H Controller USBO

n Controller SATA 0

H Controller PCle 0

H Controller Virtlo Serial 0
n Controller Virtlo SC510
@ ussredirector 1

§ ussredirector 2

Q RNG /devfurandom

Add Hardware

CTB Broker Node - Deployment Test on QEMU/KVM: 10.0.81.9 B 8 &

File virtual Machine View 5end Key

-

Details XML

CPUs
Logical host CPUs: 56

vCPU allocation:
Configuration
Copy host CPU configuration

Model:  Broadwell-IBRS

Enable available CPU security Flaw mitigations

~ Topology
Marnually set CPU topology
Sockets: 1 +
Cores: 5 - +
Threads: | 1 o

Cancel Apply

Open Communication Ports

The following table provides details for all the network connections made to and from
your Cisco Telemetry Broker appliances. To ensure that your network permits these

connections, you need to modify the applicable access controls you currently have in
place (for example, your firewall).

Client

users

Manager

Server

broker nodes
and Manager
node

external internet

Port

22/TCP

443/TCP

Description

SSH access to the console

HTTPS for secure external
communications, such as Smart

© 2024 Cisco Systems, Inc. and/or its affiliates. All rights reserved.
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Manager

Manager

each broker
node

each broker
node

users

broker
nodes and
Manager
node

customer syslog
server

customer
SMTP server

Manager

external internet

Manager

customer
DNS servers

customer-
defined port

customer-
defined port

443/TCP

443/TCP

443/TCP

53/UDP

Licensing and Software Update

Syslog telemetry for Cisco
Telemetry Broker notifications

SMTP telemetry for Cisco
Telemetry Broker notifications

HTTPS for secure management
connections

HTTPS for retrieving VPC/NSG
Flow Logs from AWS S3/Azure
SAS storage buckets,
respectively.

HTTPS for broker node to secure
access SCA server and upload
files to SCA S3 bucket.

HTTPS for secure web interface
access

DNS telemetry

In addition, you must open ports based on both the telemetry type that is sent to a broker
node and the telemetry type that a broker node sends to a destination. The following table
provides details about common ports for various telemetry types:

Port Description
514/UDP syslog
2055/UDP NetFlow v5, NetFlow v9
4739/UDP IPFIX
6343/UDP sFlow
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Migrate Configuration to a New System

Complete the following processes to back up and restore the CTB connection
configurations that you set up in the Cisco Telemetry Broker Manager.

 |tis possible for UDPD customers to migrate their existing UDPD configuration to
Cisco Telemetry Broker. For more details, see the "Importing and Exporting
UDP Director Configuration" section in the Cisco Telemetry Broker User Guide.

Run the following command on the CTB Manager Node:

$ sudo ctb-backup-config -v -f ctb config.json

When this process has finished, the connection configurations will be backed up to the
file at ~/.ctb_config.json, after which you can copy the connection configurations to
another location.

» VPC/NSG Flow Log connections are not backed up, so you need to re-create your
VPC/NSG Flow Log connections upon migrating to a new system.

* You can back up and restore your CTB connection configurations only within the
same version. If you try to do so across versions, the process may fail.

You mustrun ctb-restore-config after you complete ctb-install --init
A\ onthe Manager node. If you manually create a GUI login account, it will be
overwritten by the account information from ctb-restore-config.

Complete these steps:
1. Log out as the install user.

Copy the ctb-config.json file from an existing system.

Log in to the new system as admin.

A w0 DN

Run the following command on the CTB Manager Node:

$ sudo ctb-restore-config -v -f ctb config.json

Any inputs that you add to Cisco Telemetry Broker due to the restore are not
assigned to any nodes or clusters. You will need to assign them as required.

© 2024 Cisco Systems, Inc. and/or its affiliates. All rights reserved. -17 -
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Determine Network Configuration

Cisco Telemetry Broker supports multi-node setups, where a single Cisco Telemetry
Broker Manager can manage multiple broker nodes. Since Cisco Telemetry Broker
updates every broker node with all destinations and connections, you must carefully plan
your configuration to avoid a few common issues, which are listed below.

* You can deploy broker nodes in different telemetry segments, where the telemetry
interfaces of each broker node may not be accessible across the network. You need
to carefully construct connections so that packets from an exporter that reach a
specific node are not forwarded to destinations that are not accessible from that
node. To achieve this, you need to construct connections that exclude exporters
that might cause this routing issue. One example would be to not use any default
connections, since these would match all inputs.

» Not all destinations may be relevant to each broker node. However, with the Check
Destination Reachability feature, since each broker node attempts to ascertain
accessibility for each destination, the broker nodes could report conflicting
information back to the Manager. If the possibility exists that some broker nodes will
not be able to connect with some destinations, disable Check Destination
Reachability for those destinations.

If you are migrating to Cisco Telemetry Broker from the UDP Director, then before you
deploy the Manager node and the broker node OVA files, you need to plan how you will
connect the two VMs to the network, as differences exist between how you configure
both Cisco Telemetry Broker and the UDP Director.

Cisco Telemetry Broker differentiates telemetry traffic from management traffic. The
broker node has two interfaces: The Telemetry Network interface and the Management
Network interface. The Manager node has only the Management Network interface. The
following diagram shows how to logically deploy the Manager node and the broker
nodes.

Note that the examples in this topic represent typical deployment scenarios. To
0 learn how to set up a more advanced deployment (for example, one that uses
VLANS), contact a network administrator.
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Destinations

Teshematry Tedermstry
CTB Broker CTB Broker
Node Node
Management Margemer
CTB Manager
telemetry traffic
management traffic

Cisco Telemetry Broker receives management traffic only on the Management Network
interface; it uses this interface for all communications between the broker node and the
Manager node. Telemetry traffic is brokered primarily on the Telemetry Network interface
of the broker node. The only exception to this is when Cisco Telemetry Broker retrieves
AWS VPC Flow Logs or Azure NSG Flow L ogs, or when Cisco Telemetry Broker sends
telemetry to SCA, both of which occur over the broker node's Management Network
interface.

You can place the Manager node anywhere in the network on any subnet, but you must
have TCP connectivity over port 443 with the broker nodes.

You can use one of the following deployment modes with the broker node:
1. The telemetry subnets and management subnets are the same. In this mode, the

Telemetry Network interface and the Management Network interface on the broker
node belong to the same subnet. See Interfaces Belong to the Same Subnet.

2. The telemetry subnets and management subnets are different, so the broker node
retains its Telemetry Network interface and Management Network interface on two
separate subnets. See Interfaces Belong to Different Subnets.

Providing separate paths for both telemetry traffic and management traffic offers the
following advantages:

» Separate paths increases performance, especially when it approaches interface line
rate performance, since traffic doesn't need to share resources (such as virtual
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switches and physical NICs).

» Separating management traffic from telemetry traffic simply makes good sense for
a network configuration.

This deployment mode is very similar to that of the UDP Director, where the management
interface and the Telemetry interface are the same. The only difference in this first
deployment mode is that you need separate IP addresses for the broker node interfaces.

Refer to the following images to see how to configure this type of deployment.

CTB Broker CTB Broker
Node VM Node VM
P2 (23] P2 (123
Phiyscal NIC | Physical NIC' Physical ‘\':C*;
Telemetry Teleﬁry
a
Man:gnedrnent Management

In a virtual environment, you can accomplish this in one of the following two ways:

1. You connect the broker node's Telemetry Network interface and Management
Network interface to the same virtual switch in the hypervisor.

2. You connect the broker node's Telemetry Network interface and Management
Network interface to different virtual switches, but you connect the underlying NICs
to the same physical switch and thus the same subnet.

In this deployment mode, the Telemetry Network interface and the Management Network

interface are on different subnets. In this case you typically need separate virtual switches
for the two interfaces.

Refer to the following image to see how to configure this type of deployment.
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CTB Broker
Node VM

P2 1]
vawitch wawitch

|

| Pysical nic)| Physical nICR
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Deploy Cisco Telemetry Broker

The following describes the high-level steps for deploying broker nodes to your network
and configuring them to ingest telemetry from inputs and export telemetry to destinations:
* Deploy a Manager node and one or more broker nodes to your hypervisor
» Configure Cisco Telemetry Broker Smart Licensing
» Configure the Manager node to manage your broker nodes

» Configure one or more connections to control how broker nodes ingest and export
telemetry

» Review the state of your deployment performance from the dashboard

Note that the broker node continuously polls the telemetry interface NIC for incoming
telemetry, resulting in high CPU utilization. It is normal to see high CPU utilization of the
broker node.

» Asingle Cisco Telemetry Broker deployment supports a maximum of 10
destinations per input and 10 broker nodes per Manager node.

 If you disable exporters tracking, each broker node supports a maximum of 100k
exporters. If you enable exporters tracking for one or more inputs, we recommend
that you do not track more than 1000 exporters (totaled across all inputs), as this
may result in degraded performance.

(For information about disabling and enabling exporters tracking, see the "UDP
Inputs" topic in the Cisco Telemetry Broker User Guide.)

» A destination supports a maximum of 1000 subnets (totaled across all connections
for that destination). Adding more than 1000 subnets may result in data loss.
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VMWare Setup

We have tested the following instructions on VMWare ESXi 6.7.

0 You need to install and configure the Manager Node before you install the broker
node(s).

VMWare: Install the Manager Node

Complete the following steps in order:

1. Download the Manager Node OVA file.

Deploy the Manager Node.

Configure Resource Reservations.

Verify VM Time Settings.

Log in as the install user.

Run the sudo ctb-install --init command.

Configure the first super user account.

Log out.

© N o g &~ e N

‘ 0 You need to install and configure the Manager Node before you install the broker
node(s

1. Download the Manager Node OVA File

1. Download the Manager Node OVA file.

2. On software.cisco.com, check the SHA512sum value of the OVA file.

3. After the OVA file is downloaded, verify that the SHA512sum value of the OVA file
matches the SHA512 Checksum value on software.cisco.com. To do this, run the
following command:

shab5l2sum <path/to/file>

On software.cisco.com, you can view the SHA512sum value by hovering your
cursor over the tooltip for the link.
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2. Deploy the Manager Node

1. Loginto the VMWare vSphere web user interface console.

2. From the side menu, right-click Virtual Machine and then choose Create/Register
VM.

vmware ESXi ootd-ee lancope. iscnisbacom = | Help v |
(] md-esxi-1
() Get vCenter Sarver | 151 CreataRegister VM | [l Shut down [ Reboct | @ Refresh | 8 Actions pad FREC- 0.1 e
N '
md-esxi-1 USED: 2.4 GHz CAPACITY. 27.5 GHz
i 6.7.0 Update 3 (Bulld 14320088} MEMORY PREE: 4000 08
State Naoemal (rot connectad o ary wCanier Servar) e r— 5!
. Uptime: 24181 days USED: 72.76 GB CAPACITY. 63,86 G
STORAGE FREE. 100.32 68
USED: 44518 58 CAPACITY. 540.5 58
= Hardware = Configuration
Masusactures Cisco Systems knc Image profile {Uipdated) Vidware-ESX6-8.7.0-13008603-Custom-Cisoo-8.
7.2.1 (Cie
Modal UCSC-Ca20-MSSX oot
vEphere HA state Mot configured
+ lcru 12 CPUs x ImaiiF) XeoniR) Goid 5118 CPU @ 2.30GHz
+ viotion Supported
. Moy €3.66 GB
Wl Persistent Memary []:] = System Information
'&\lhudluh 0 8 used, 0 8 capacity Datetime on host Wednesday, June 23, 2021, 21:18:24 UTC
= €3 Natworking Irestall date Tuesday, March 10, 2020, 23:7-13 UTC
Hostnarme rd-gaxi-1 Assat lag Unknows
| Rocant tasks B
Task. v Target v  Initiator v | Queusd w | Started v Fesult & w Completed v w
=

3. Choose Deploy a virtual machine from an OVF or OVA file.

© 2024 Cisco Systems, Inc. and/or its affiliates. All rights reserved. -24 -



VMWare Setup

) New virtual machine

<(CECTSITNE  Select creation type

2 Select OVF and VMDK flles How would you like to create a Virtual Machine?

3 Select storage

4 License agreoments Create a new virtual machine This option guides you through the process of creating a
5 Deployment options virtual machine from an OVF and VMDK files.

6 Additional settings Deploy a virtual machine from an OVF or OVA file

7 Ready to complete
ad Register an existing virtual machine
Select creation type
Back Next Finish Cancel

4. Enter the name of the OVA file.

") New virtual machine - ctb-manager

¥ 1 Select creation type Select OVF and VMDK files
Select the OVF and VMDK files or OVA for the VM you would like to deploy
3 Select storage
4 License agreements

Enter a name for the virtual machine.
5 Deployment options

e raree!

7 Ready to complete Virtual machine names can contain up to 80 characters and they must be unique within each ESXi instance.

x @@ ctb-manager-node.ova

| Back | Next Finish Cancel
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5. Configure the settings as shown in the following image.

91 New virtual machine - broker
v 1 Select creation type Deployment options
v 2 Select OVF and VMDK files Select deployment options

+ 3 Select storage

B4 4 Deployment options
Network mappings

5 Ready to complete Management Network VM Network
Telemetry Network Telemtry port group v

Dsployement ype 1 Gbps Deployment -

This deployment option is bast suited for processing telemetry at a rate of 1 Gbp
s or below. It uses 2 CPUs and 4G of RAM

Disk provisioning @ Thin O Thick

Power on automatically

| Next Finish Cancel

6. Click Finish. The system will start and prompt you to log in.

© 2024 Cisco Systems, Inc. and/or its affiliates. All rights reserved. -26 -



VMWare Setup

") New virtual machine - ctb-manager

¥ 1 Select creation type Ready to complete
¥ 2 Select OVF and VMDK files
+ 3 Select storage

+ 4 Deployment options

Review your settings selection before finishing the wizard

V Product ctb-manager-node-316cc5398¢53f4b0d 1 defd23543780c0431B9840
VM Name ctb-manager
Disks ctb-manager-node-disk1.vmdk
Datastore datastore1
Provisioning type Thin
Network mappings
Guest OS5 Name Unknown

' ! Do not refrash your browser while this VM is being deployed.

Back Next Finish | | Cancel

3. Configure Resource Reservations

Make sure you reserve virtual machine resources recommended per the

Deployment Requirements. Otherwise, the actual allocated resources could

be less than the recommended value, and you might receive one or both of the
0 following alerts:

¢ Insufficient CPU Allocated

« Insufficient Memory Allocated

The Manager node requires that all computer resources are dedicated to the VM. To
ensure this occurs, complete the following steps:

1. Inthe VMware interface, click the Manager node VM that you deployed in the
previous section, Deploy the Manager Node.

2. Click Edit to open the window in which you will edit the VM's settings.
3. Choose Virtual Hardware > CPU > Reservations.

4. To determine the Reservations value, multiply the number of CPUs on the VM by the
GHz value of your hypervisor's processor type (which you can find on the
Hypervisors Summary > CPU > Processor Type screen).
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» For example, if your hypervisor lists the processor type as @2.40 GHz, and
your VM is allocated 8 CPUs, then you would use this formula: 8 x 2.40 GHz =
19200 MHz. In this case, you should specify 19200 MHz as the Reservation
value.

» Some VMware products (for example, VCenter) provide a drop-down list that
includes a value labeled as Maximum that reflects the pre-calculated value
for you.

5. Choose Virtual Hardware > Memory > Reservations.
6. Check the Reserve all guest memory (all locked) check box.

7. Click Save to save these settings.

4. Verify VM Time Settings

The VM relies on the hypervisor to provide accurate time, and the default settings should
ensure this is occurring. However, we recommend that you verify this by completing the
following steps:

1. Inthe VMware interface, click the Manager node VM that you deployed in the
previous section, Deploy the Manager Node.

Click Edit to open the window in which you will edit the VM's settings.
Choose VM Options > VMware Tools > Time.

Ensure the Synchronize guest time with host check box is checked.

o & N

Click Save to save these settings.

5. Log In as the Install User

From the Manager node virtual machine within the vmware user interface, open a web
console and log in to the virtual machine (the username is install; there is no password).

CTBM-D1

an GHUsLinux 10 ctb-manager-node-taghuild ttyl

ogin: in 1
ghuild 4.1
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6. Run the sudo ctb-install --init Command

If you plan on restoring config from a different CTB deployment, then you must

A run ctb-restore-config after completing ctb-install --init and logging
out as the install user. For more information, see Migrate Configuration to a
New System.

1. Runthe sudo ctb-install --init command.
2. Enter the following information:
» Password for the admin user
The password must meet the following requirements:
o Contain at least 8 characters
° Contain at least 1 lowercase letter
° Contain at least 1 uppercase letter
o Contain at least 1 digit
o Contains at least 1 of these special characters: @ #S %~ & * !+ ?
° Cannot be a commonly-used phrase or sequence

o Cannot be similar to any identifying attributes of the user (such as the
username)

» Hostname (max 255 characters, letters and numbers only)
* You can enter one or both of the following IP address parameters:

° |Pv4 address, subnet prefix length, and default gateway address for the
Management Network interface

o |Pv6 address, subnet prefix length, and default gateway address for the
Management Network interface

* Valid DNS nameserver IP address that is reachable from the virtual machine
(you can enter one or two)

0 To change any individual parameters in the future, run the sudo ctb-install
--configcommand.

7. Configure the First Super User Account

If this is the first time you are logging in to the Manager web interface, you must first
create the first Super user account before you install any broker nodes. We suggest
assigning the user name of webadmin so as not to confuse it with the admin user.
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* Ina web browser, navigate to the following site to create it: https://<manager_ip_
address>.

8. Logout

To log out, type exit.

VMWare: Install the Broker Node

Complete the following steps in order:

Download the Broker Node OVA file.

—

Deploy the Broker Node.

Configure Resource Reservations.

Verify VM Time Settings.

Log in as the install user.

Run the sudo ctb-install --init command.

Run the sudo ctb-manage command.

Log out.
Configure the Telemetry Interface.

© ©®© N o g & DN

‘ 0 You need to install and configure the Manager Node before you install the broker
node(s

1. Download the Broker Node OVA File
1. Download the Broker Node OVA file.

2. On software.cisco.com, check the SHA512sum value of the OVA file.

3. After the OVA file is downloaded, verify that the SHA512sum value of the OVA file
matches the SHA512 Checksum value on software.cisco.com. To do this, run the
following command:

shab5l2sum <path/to/file>

On software.cisco.com, you can view the SHA512sum value by hovering your
cursor over the tooltip for the link.

© 2024 Cisco Systems, Inc. and/or its affiliates. All rights reserved. -30-



https://software.cisco.com/download/home/286328124/type/286328307

VMWare Setup

2. Deploy the Broker Node

1. Loginto the VMWare vSphere web user interface console.

2. From the side menu, right-click Virtual Machine and then choose Create/Register
VM.

vmware Esxi rotrre-ma- | lacope cecolsba com + Hep v |
() md-esxi-1
() Get vCenter Server | T Creste/Plegister VM | [y Shut down  [B5 Reboot | G Refresh | £ Actions o ] FREE-U 1 Ot
rnd-esxi-1 USED: 21.4 GHe CAPACITY. 275 GHe
Narsion: 6.7.0 Update 3 {Bulld 14320088 MEMORY FREE. 40,59 08
A State Noeemal (rot connaciad 1o any vCanar Servar) ol
) Uptme 24161 dayn. USED. 22 76 0B CAPACITY. 83,56 08
STORAGE FREE: 10032 G&
USED: 448 18 GB CAPACITY: 5405 G
= Hardwans = Gonfiguration
Manutactures Gisoo Systems Ing Image profie (Updated) Viware-E5Xi-6.7.0-13006603-Custom-Cisco-6.
7.2.1 (Ciscol
Model UCSC-C220-MSEX !
viphers HA state Net configured
+ dcru 12 GPUS x ImelfF) XeoniF) Gold 5118 CPU & 2.30GHz
+ vMation Supported
. amory .56 GB
[ Porsistent Memary [1:} = System information
+ [ Virtual Sash 08 used, 08 capacity Date/ftime an hast Wadnesday, June 23, 2021, 21:18:24 UTC
= £ Networking Instail date Tussday, March 10, 2020, 23:27:13 UTC
Hostname rch-esxi-1 Asset lag Unknown
| Recent tasks. l I
Task v Trgat ~ | Initiator ~ | Queued | Started « FRosult a w Completed v v
- |

3. Choose Deploy a virtual machine from an OVF or OVA file.
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) New virtual machine
v Select creation type
2 Sslect OVF and VMDK files How would you like to create a Virtual Machine?
3 Select storage
4 License agreements - )
a new virtual machine This option guidas you through the process of creating a
6 Deployment options virtual machine from an OVF and VMDK files.
6 Additional settings Deploy a virtual machine from an OVF or OVA file

7 Ready to complete
Register an existing virtual machine
Select creation type
Back | Next ] Finish

Cancel
4. Enter the name of the OVA file you downloaded in Step 3.
741 New virtual machine - ctb-broker
¥ 1 Select creation type Select OVF and VMDK files
Salect the OVF and YMDK files or OVA for tha VM you would like to deploy
3 Select storage
4 License agreements Enter a name for the virtual machine.
s ctb-brok
6 Additional settings roer
7 Ready to complete Virtual machine names can contain up to 80 characters and thay must be unigue within each ESXi instance.
% B ctb-broker-node.ova
Back MNext | Finish Cancel
-32-
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5. Set the Default type to 1 Gbps, 10 Gbps, or Transformation Capable as appropriate
for your installation. Configure the remaining settings as shown in the following

image.
) New virtual machine - broker
v 1 Select creation type Deployment options
+ 2 Select OVF and VMDK files Select deployment
+ 3 Select storage
4+ Dovomentoptons |
5 Ready to complete i Management Network VM Network
Telemetry Network Telemtry port group -
g 1 Gbps Deployment v
This deployment oplion is best suited for processing telemetry at a rate of 1 Gbp
s or below. It uses 2 CPUs and 4G of RAM
Disk provisioning ® Thin O Thick
Power on automatically

Back Next Finish Cancel

6. Click Finish.
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74 New virtual machine - ctb-broker

¥ 1 Select creation type Ready to complete
¥ 2 Select OVF and VMDK files Review your settings selection befar finishing the wizard
v 3 Selact storage
v 4 Deployment options
Product ctb-broker-node-3f6cc5388c53f4b0d 1 defd23543780c04 3189840
0 sy tocompio
VM Name ctb-broker
Disks ctb-broker-node-disk1.vmdk
Datastore datastore1
Provisioning type Thin
Network mappings
Guest OS Name Unknown
Profile This deployment option is best suited for processing telemetry at a rate of 1 Gbps

of below. It uses 2 CPUs and 4G of RAM.

Do not refresh your browser while this VM is being deployed.

Back Next Finish Cancel

3. Configure Resource Reservations

Make sure you reserve virtual machine resources recommended per the

Deployment Requirements. Otherwise, the actual allocated resources could

be less than the recommended value, and you might receive one or both of the
0 following alerts:

¢ |nsufficient CPU Allocated

* Insufficient Memory Allocated

The broker node requires that all computer resources are dedicated to the VM. To ensure
this occurs, complete the following steps:

1. Inthe VMware interface, click the broker node VM that you deployed in the previous
section, Deploy the Broker Node.

2. Click Edit to open the window in which you will edit the VM's settings.
Choose Virtual Hardware > CPU > Reservations.

4. To determine the Reservations value, multiply the number of CPUs on the VM by the
GHz value of your hypervisor's processor type (which you can find on the
Hypervisors Summary > CPU > Processor Type screen).
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» For example, if your hypervisor lists the processor type as @2.40 GHz, and
your VM is allocated 8 CPUs, then you would use this formula: 8 x 2.40 GHz =
19200 MHz. In this case, you should specify 19200 MHz as the Reservation
value.

» Some VMware products (for example, VCenter) provide a drop-down list that
includes a value labeled as Maximum that reflects the pre-calculated value
for you.

5. Choose Virtual Hardware > Memory > Reservations.
6. Check the Reserve all guest memory (all locked) check box.

7. Click Save to save these settings.

4. Verify VM Time Settings

The VM relies on the hypervisor to provide accurate time, and the default settings should
ensure this is occurring. However, we recommend that you verify this by completing the
following steps:

1. Inthe VMware interface, click the broker node VM that you deployed in Section 2,
Deploy the Broker Node.

Click Edit to open the window in which you will edit the VM's settings.
Choose VM Options > VMware Tools > Time.

Ensure the Synchronize guest time with host check box is checked.

o & N

Click Save to save these settings.

5. Log In as the Install User

From the broker node virtual machine within the vmware user interface, open a web
console and log in to the virtual machine (the username is install; there is no password).

CTBM-D1

an GHUsLinux 10 ctb-manager-node-taghuild ttyl

ogin: in 1
ghuild 4.1
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6. Run the sudo ctb-install --init Command

1. Runthe sudo ctb-install --init command.
2. Enter the following information:
e Password for the admin user
The password must meet the following requirements:
° Contain at least 8 characters
o Contain at least 1 lowercase letter
o Contain at least 1 uppercase letter
o Contain at least 1 digit
o Contains at least 1 of these special characters: @ #S % & * !+ ?
o Cannot be a commonly-used phrase or sequence

o Cannot be similar to any identifying attributes of the user (such as the
username)

« Hostname (max 255 characters, letters and numbers only)
» You can enter one or both of the following IP address parameters:

o |Pv4 address, subnet prefix length, and default gateway address for the
Management Network interface

° |Pv6 address, subnet prefix length, and default gateway address for the
Management Network interface

¢ Valid DNS nameserver IP address that is reachable from the virtual machine
(you can enter one or two)

o To change any individual parameters in the future, run the sudo ctb-install
--configcommand.

7. Run the sudo ctb-manage Command

1. Runthe sudo ctb-manage command.
2. Enter the following information:
» |P address of the Manager node
» Username of the super user account you create in the Manager node

» Password of the super user account you create in the Manager node
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8. Logout

To log out, type exit.

9. Configure the Telemetry Interface

Go to Configure the Telemetry Interface.

When you remove a broker node from the Manager, you need to deactivate the

0 node to prevent telemetry from continuing to be sent through the assigned
inputs. To do this, run the ctb-manage command, then choose option d to
deactivate the node.
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KVM Setup

The following instructions for setting up your KVM (Kernel[based] Virtual Machine) are
based on the following:

e libvirt 7.1.0

e gemu-kvm 5.2.0

e Linux Kernel 5.10.26

« Virtual Machine Manager (virt-manager) Ubuntu 2.2.1

Before you proceed, confirm in your Virtual Machine Manager that you have
o chosen the Enable XML Editing option. If your version of Virtual Machine

Manager does not support XML editing, you can perform the same step using the

virsh edit command on your KVM host.

1. Open the VM Manager and choose Edit > Preferences.

Virtual Machine Manager o L

File Edit View Help
- Connection Details

=

Delete
[ _o: JE— I

" B

2. Check the Enable XML Editing check box and click Close.
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General Polling New WM Console Feedback

General
Enable system trayicon

& Enable XML editing

'

Close

KVM: Install the Manager Node

Complete the following steps in order:

1. Download the Manager Node QCOW?2 file.

Launch the virtual machine.

Log in as the install user.

Run the sudo ctb-install --init command.

Configure the first super user account.

Log out.

o g &~ W N

‘ o You need to install and configure the Manager Node before you install the broker
node(s

1. Download the Manager Node QCOW?2 File

1. Download the Manager Node QCOW?2 file.
2. On software.cisco.com, check the SHA512sum value of the QCOW?2 file.

3. After the QCOW?2 file is downloaded, verify that the SHA512sum value of the
QCOW?2 file matches the SHA512 Checksum value on software.cisco.com. To do
this, run the following command:

shab512sum <path/to/file>

On software.cisco.com, you can view the SHA512sum value by hovering your
cursor over the tooltip for the link.
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2. Launch the Virtual Machine

1. Open the Virtual Machine Manager on your Linux system running KVM and click
Create a new virtual machine.

Virtual Machine Managqer o =

File Edit WView Help

2. In Step 1 of the Create a new virtual machine dialog, check the Import existing
disk image option. Click Forward.

New VM

m Create a new virtual machine

Connection: QEMU/KVM

Choose how you would like to install the operating system
Local install media (IS0 image or CDROM)
Metwork Install (HTTR, HTTPS, or FTF)
MHetwork Boot (PXE)

© import existing disk image

Cancel Forward
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3. In Step 2 of the Create a new virtual machine dialog, do the following:

a. Enter the existing storage path to your QCOW?2 file that you downloaded in
Step 1.

b. Forthe operating system, choose Debian Buster.

c. Click Forward.

New VM

m Create a new virtual machine

Provide the existing storage path:

Mvarflibflibvirtfimages/spindlefctb-manager.qrow2 Browse...

Choose the operating system you are installing:
Q, Debian 10 a

Cancel Back Forward

Make sure you reserve virtual machine resources recommended per the
Deployment Requirements. Otherwise, the actual allocated resources could
be less than the recommended value, and you might receive one or both of the

0 following alerts:

« Insufficient CPU Allocated
 Insufficient Memory Allocated

4. In Step 3 of the Create a new virtual machine dialog, do the following:
a. Inthe Memory (RAM) field, set the entry to at least 8 GB.
b. Inthe CPUs field, set the entry to at least 4.

c. Click Forward.
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New VM

m Create a new virtual machine

Choose Memory and CPU settings
Memory (RAM): 8192 — + | MiB
Up to 257821 MiB available on the host
CPUs: 4 - +

Up to 56 avaslable

Cancel Back Forward

5. In Step 4 of the Create a new virtual machine dialog, do the following:

a. Inthe Name field, enter ctb-manager.

b. Check the Customize configuration before install check box.
c. Click Finish.

Hew VM

m Create a new virtual machine

Ready to begin the installation

Mame: ctb-manager

05: Debian 10
Install: Import existing OS image
Memory: 8192 MiB
CPUs: 4
Storage: ... fimages/spandle/ctb-manager.goowd

Customize configuration before install

» Metwork selection

Cancel Back Finish

6. Do the following:

a. From the side menu, choose Overview.
b. Click the XML tab.
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c. Change theline <timer name="rtc" tickpolicy="catchup"/>to
<timer name="rtc" tickpolicy="catchup" track="guest"/>

d. Click Apply.

CTE Manager on QEMU/MVM

o Beginimtallation ) Cancelinstallation

- Overview AML

B o5 information —

O crus B

. Memory <feat
800t Options

o Virtio Disk 1 SVBBOPT 31

3 NICIESTee Jienteres> =

7 Tablet cclock offseta"wtc™>

g sondicm S Aar Bameene e mect e T

- Comole - o>

s Channel gemuga - aand.te.ean Sashis

 Channel spice r d-to-disk

B video g o onr

!CMTWNO <eaulat rafusr/bin/qenu-systen - x86 S4</enulator

@ usereduecton “disk type="file® devices"disk">

a USB Redurector 2 'I., . ¢ -
RMC [dev/urandom arget ¢ )
Add Hardware Cancel Apply

7. Do the following:
From the side menu, choose VirtlO Disk 1.

b. On the Details tab, under Advanced Options, choose SCSI from the Disk bus
drop-down list.

c. Click Apply.
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CTB Manager on QEMU/KVM x

Begin Installation @@ CancelInstallation

E Overview Details
B osinformation —
— Virtual Disk
LJ CPUs Source path: /var/libflibvirt/images/spindle/ctb-manager.qcow2
=5 Memory Device type: VirtlO Disk 1
Boot Options Storage size: 39.06 GiB

Virtlo Disk 1 Readonly:

Shareable:
Ty NIC:18:51:ee

# Tablet + Advanced options
Bl Display spice Disk bus:  5CSI -
¥ Soundich9 Serial number: | SATA

Console ece)

Storage format
Channel gemu-ga

channel spice ¥ Performance o
B video QXL
B controller useo

#¢) USB Redirector 1
#) usBRedirector 2
RNG /dev/urandom

Add Hardware Remove Cancel Apply

8. Click Begin Installation in the top left corner of the page.

3. Log In as the Install User

From the Manager node virtual machine within the vmware user interface, open a web
console and log in to the virtual machine (the username is install; there is no password).

CTB-M-01 Actions

Debian GHUsLinux 10 cth-ma r-node-taghuild ttyl

11

bed in the

to the extent
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4. Run the sudo ctb-install --init Command

If you plan on restoring config from a different CTB deployment, then you must
run ctb-restore-config after completing ctb-install --init andlogging
out as the install user. For more information, see Migrate Configuration to a
New System.

1. Runthe sudo ctb-install --init command.
2. Enter the following information:
» Password for the admin user
The password must meet the following requirements:
o Contain at least 8 characters
° Contain at least 1 lowercase letter
o Contain at least 1 uppercase letter
o Contain at least 1 digit
o Contains at least 1 of these special characters: @ #S %~ & * !+ ?
° Cannot be a commonly-used phrase or sequence

o Cannot be similar to any identifying attributes of the user (such as the
username)

« Hostname (max 255 characters, letters and numbers only)

» Specify the interface names if they are different from the default
names: default mgmt = 'ens160' and default telem = 'ens192.'

* You can enter one or both of the following IP address parameters:

° |Pv4 address, subnet prefix length, and default gateway address for the
Management Network interface
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o |Pv6 address, subnet prefix length, and default gateway address for the
Management Network interface

 Valid DNS nameserver IP address that is reachable from the virtual machine (you
can enter one or two)

0 To change any individual parameters in the future, run the sudo ctb-install
--config command.

5. Configure the First Super User Account

If this is the first time you are logging in to the Manager web interface, you must first
create the first Super user account before you install any broker nodes. We suggest
assigning the user name of webadmin so as not to confuse it with the admin user.

» In a web browser, navigate to the following site to create it: https://<manager_ip_
address>.

6. Logout

To log out, type exit.

KVM: Install the Broker Node

Complete the following steps in order:

1. Download the Broker Node QCOW?2 file.

Launch the virtual machine.

Log in as the install user.

Run the sudo ctb-install --init command.

Run the sudo ctb-manage command.

Log out.
Configure the Telemetry Interface.

N o o &~ DN

o You need to install and configure the Manager Node before you install the broker
node(s).

1. Download the Broker Node QCOW?2 File

1. Download the Broker Node QCOW?2 file.
2. On software.cisco.com, check the SHA512sum value of the QCOW?2 file.
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3. After the OVA file is downloaded, verify that the SHA512sum value of the OVA file
matches the SHA512 Checksum value on software.cisco.com. To do this, run the
following command:

sha512sum <path/to/file>

On software.cisco.com, you can view the SHA512sum value by hovering your
cursor over the tooltip for the link.

2. Launch the Virtual Machine

1. Open the Virtual Machine Manager on your Linux system running KVM and click
Create a new virtual machine.

virtual Machine Manager o =

File Edit View Help

2. In Step 1 of the Create a new virtual machine dialog, check the Import existing
disk image option. Click Forward.
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Hew VM

m Create a new virtual machine

Connection: QEMU/KVM

Choose how you would like to install the operating system
Local install media (150 image or CDROM)
Metwork Install (HTTP, HTTPS, or FTP)
HNetwork Boot (PXE)
0 Import existing disk image

Cancel L Forward

3. In Step 2 of the Create a new virtual machine dialog, do the following:

a. Enter the existing storage path to your QCOW?2 file that you downloaded in
Step 1.

b. Forthe operating system, choose Debian Buster.

c. Click Forward.

Make sure you reserve virtual machine resources recommended per the

Deployment Requirements. Otherwise, the actual allocated resources could

be less than the recommended value, and you might receive one or both of the
0 following alerts:

¢ |nsufficient CPU Allocated

* Insufficient Memory Allocated
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New VM

m Create a new virtual machine

Provide the existing storage path:
Jvarflibflibvirtfimages/spindle/ctb-broker-node.qcow Browse...

Choose the operating system you are installing:

Q, Debian 10 L x]

Cancel Back Forward

4. In Step 3 of the Create a new virtual machine dialog, do the following:
In the Memory (RAM) field, set the entry to at least 2 GB.

b. Inthe CPUs field, set the entry to 2 (assigning additional CPU to the broker
does not necessarily improve performance on KVM).

c. Click Forward.

NHew VM

m Create a new virtual machine

Choose Memory and CPU settings:

Memory: 1024 - +
Up to 15877 MIB svailable on the host
CPUs: 2 -+

Up to 4 available

Cancel Back Forward
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5. In Step 4 of the Create a new virtual machine dialog, do the following:
a. Inthe Name field, enter ctb-broker.
b. Check the Customize configuration before install check box.
c. Click Finish.

Hew VM

Create a new virtual machine

Ready to begin the installation

Mame: cth-broker

05: Debian 10
Install: Import existing OS image
Memory. 2048 MiB
CPUs: 2
Storage: ...ages/spindle/ctb-broker-node.goow?

Customize configuration before install

* Network selection

Cancel Back Finish

6. Do the following:
From the side menu, choose Overview.

b. Click the XML tab.

c. Change theline <timer name="rtc" tickpolicy="catchup"/>to
<timer name="rtc" tickpolicy="catchup" track="guest"/>

d. Click Apply.
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ctb-broker on QEMU/KVM x

o Begininstallation

B osinformation
LJ crus
= Memory

', Boot Options
- VirtiO Disk 1
Ty NIC:63:1c6f
|.# Tablet
M Display spice
g sound ichs
ey Console
G Channel gemu-ga
Gy Channel spice
B video QL
B controller usg 0
@ useRedirector 1
@ useRedirector 2

RNG /devfurandom

Add Hardware

e Cancel Installation

Details XML

<domain type=“"kvm">
<name>Cctb-broker</name>
<uuid>el983747-516a-4fc4-8a2c-0a48789f9b4l</uuid=>
<métadata>

<libosinfo:libosinfo xmlns:libosinfo="http://libosinfo.org/xmlns

<libosinfo:os id="http://debian.org/debian/10"/>

</libosinfo:libosinfo>
</metadata>
<memory>2097152</memory>
<currentMemory>2097152</currentMemory>
-'.\.'rpun-ﬂ ,.-".’fp'.;
l'.us.'\-
<type arch="x86 64° machine="q35">hvm</type>
<boot dev="hd"/>
</fos>
=zfeatures>
<acpi/>
=aplc/>
<ymport state="off"/>
</features>
<cpu mode="host-model®/>
<clock offset="utc">

<timer name="rtc* tickpolicy="catchup® track="guest® /:

<timer name="pit* tickpolicy="delay*/>
<timer name="hpet” present="no"/>
<fclock>

<Dl

Cancel

7. Do the following:

a. From the side menu, choose VirtlO Disk 1.

Apply

b. On the Details tab, under Advanced Options, choose SCSI from the Disk bus
drop-down list.

c. Click Apply.
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CTB Manager on QEMU/KVM x

@ Cancel Installation

c‘-.-,- Begin Installation

B overview

B osinformation

] cpus

== Memory

- Boot Options

Ty NIC:18:51:ee

|.# Tablet

Bl Display Spice

i Sound ich9

G Console

a3 Channel gemu-ga

(a3 Channel spice

Bl video QxL

! Controller USB O

@ useRredirector 1

@ useRredirector 2
RNG /devfurandom

Add Hardware

Details XML

Virtual Disk

Source path: fvarflib/libvirt/images/spindle/ctb-manager.qcow2
Device type: VirtlO Disk 1
Storage size: 39.06 GiB

Readonly:

shareable:

+ Advanced options
Disk bus: = SCSI -

Serial number: SATA

Storage format: | 5€5!
UsB

» Performance o
Virtlo

Remove Cancel

Apply

8. From the side menu, choose Add Hardware > Network. Click Finish.
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Add New Virtual Hardware =

- Storage
B controller
| Network |
Y Input
B Graphics
W Sound
= Serial
Parallel
| Console
Channel
USB Host Device
PCl Host Device
M video
M watchdog
&l Filesystem
Smartcard
& USB Redirection
U TPMm
RNG
Panic Notifier
f3  Virtio VSOCK

Details
Network source:  vijrtyal network 'default’ : NAT

MAC address: 52:54:00:9a:¢b:68

Device model virtio -

Cancel Finish

9. Click Begin Installation.

3. Log In as the Install User

From the broker node virtual machine within the vmware user interface, open a web
console and log in to the virtual machine (the username is install; there is no password).

CTB-M.01

Debian GHU/Linux 10 cth-man —node-taghuild t1yl

LUTELY WO HARRAWTY, to the ewxtent

yild:™E _
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4. Run the sudo ctb-install --init Command

1. Runthe sudo ctb-install --init command.
2. Enter the following information:
e Password for the admin user
The password must meet the following requirements:
o Contain at least 8 characters
° Contain at least 1 lowercase letter
o Contain at least 1 uppercase letter
o Contain at least 1 digit
o Contains at least 1 of these special characters: @ #S % & * !+ ?
° Cannot be a commonly-used phrase or sequence

o Cannot be similar to any identifying attributes of the user (such as the
username)

« Hostname (max 255 characters, letters and numbers only)

» Specify the interface names if they are different from the default
names: default mgmt = 'ens160' and default telem = 'ens192.'

* You can enter one or both of the following IP address parameters:

° |Pv4 address, subnet prefix length, and default gateway address for the
Management Network interface

° |Pv6 address, subnet prefix length, and default gateway address for the
Management Network interface

Valid DNS nameserver |IP address that is reachable from the virtual machine
(you can enter one or two)

o To change any individual parameters in the future, run the sudo ctb-install
-—configcommand.
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5. Run the sudo ctb-manage Command
1. Runthe sudo ctb-manage command.
2. Enter the following information:
» |P address of the Manager node
» Username of the super user account you create in the Manager node

» Password of the super user account you create in the Manager node

6. Logout

To log out, type exit.

7. Configure the Telemetry Interface

Go to Configure the Telemetry Interface.

When you remove a broker node from the Manager, you need to deactivate the

o node to prevent telemetry from continuing to be sent through the assigned
inputs. To do this, run the ctb-manage command, then choose option d to
deactivate the node.
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Configure the Telemetry Interface

1. Loginto Cisco Telemetry Broker. In a web browser, enter the Manager's
management interface IP address and press Enter to navigate to the Manager's
web interface login.

2. From the main menu, choose Broker Nodes.

3. Inthe Broker Nodes table, click the applicable broker node.

4. Inthe Telemetry Interface section, click the /(Edit) icon (indicated by the arrow in
the following image).

'é|“s'é|‘;‘ Telemetry Broker Overview  DataFlow  Destinations  Inputs  BrokerNodes  Manager Node  Integrations TN -

Broker Nodes / staging-node-81-36

staging-node-81-36 ¥ Remove Broker Node
General Status Received Rate Sent Rate
staging-node-81-36
...... o 2.35.. 7.03 .
Ietwere _Active e oo
Telemetry Interface _» y
x 2 Pud

ens192

. - . . | tastin MLaslun Last 7d Lost3od |
S S S QP =t h | ez | sre )

Megrics .

5. Configure the IP and Gateway addresses (enclosed in red border).
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Manage High Availability Clusters

Cisco Telemetry Broker high availability provides highly available IPv4 and IPv6 virtual
IP addresses to be targets for your inputs, ensuring reliable delivery of telemetry from
inputs to destinations.

To establish Broker Node high availability, you can create high availability clusters and
assign multiple broker nodes to each. In each cluster, one broker node is designated
Active, meaning it passes telemetry and serves metrics to Cisco Telemetry Broker, and
the rest are designated Passive, meaning they are not passing telemetry or serving
metrics currently. If an Active broker node stops passing telemetry or otherwise loses
connectivity with Telemetry Broker, one of the Passive broker nodes is promoted to
Active broker node and starts passing telemetry.

Note the following about clusters:

» Each broker node can only belong to one cluster at a time.

» You can create a cluster without assigning a broker node, but note that the cluster
will not receive telemetry until you add a node.

* You can assign an input to an empty cluster, but note that the cluster will not receive
telemetry until you add a node.

» When you remove a broker node from a cluster, that node no longer has any inputs
assigned to that cluster.

» Keep in mind that if you create a cluster with only one broker node and this broker
node fails, no other broker node is available to be promoted to Active broker node.
Similarly, if all broker nodes within a cluster fail, no broker node can be promoted to
Active broker node. If a broker node fails, bring it back online as soon as possible.

* You cannot choose which broker node is active in a given cluster.

o If an Active broker node for a virtual IP address fails, one of the Passive broker
nodes in the same cluster becomes the Active broker node for the virtual IP
address. When the failed broker node comes back up again, it remains a Passive
broker node. If you want to make that node active again, you will need to do so
manually using the provided commands in the Move a VIP to a Specific Node
section in this chapter.

¢ You can assign either a virtual IPv4 or virtual IPv6 address, or both, to a cluster.
Telemetry Broker uses this virtual IP address to communicate with the cluster and
promote Passive broker nodes to Active broker nodes when an Active broker node
loses connectivity with Telemetry Broker.
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For information about how HA clusters are updated during the Cisco Telemetry Broker
software update process, see the "Software Update" chapter in the Cisco Telemetry
Broker User Guide.

High availability configures the VIP address broker node's Telemetry Network interface.
Note that the Telemetry Network interface on each broker node in the cluster must
already be configured with a primary IPv4 or IPv6 IP address, as well as with a subnet
prefix length and a gateway. You can configure these in the Telemetry Network interface.

You must configure the IPv4 or IPv6 VIP IP addresses to be in the same subnet as the
primary IP addresses of the Telemetry Network interfaces in the cluster, since the VIP
must be in the same subnet as well. This ensures proper routing via the preconfigured
Gateway and fast failover.

If the VIP addresses are not in the same subnet as the primary IP addresses of the
Telemetry Network interfaces, or if the Telemetry Network interfaces within a Cluster are
configured with different subnets, then it is very likely that high availability will not work.

The Cisco Telemetry Broker implementation relies on two commonly used Linux
packages to provide the underlying high availability infrastructure:

Corosync: This is the low-level cluster engine that provides the underlying
communication between cluster nodes. It also provides the quorum capability to make the
decision on the role of each node (Active or Standby).

Pacemaker: This is Cluster Resource Manager which manages all the relationships
between the machines and the applications. It uses Corosync to communicate.
View Current Cluster Status

To view the current status of the cluster, including the status (Offline or Online) of each
node and the location of the IPv4 VIP (vip4) and the IPv6 VIP (vip6) IP address, complete
the following steps:

1. Log in as the admin to any of the broker nodes in the cluster from the console into
the virtual machine provided by VMWare vCenter, or via SSH. Use the password
that was supplied during node installation.

2. Runthe sudo crm mon command. This presents a view of the currently configured
attributes on the cluster. You can see more details about this command here.

3. Exit the tool by pressing Ctri+C.
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L N N admin@titan-8HIP2JLB: ~

Stack: corosync

Current DC: 10.0.81.31 (version 2.0.1-9e909a5bdd) - partition with quorum
Last updated: Tue Jan 26 16:16:24 2021

Last change: Tue Jan 26 15:45:04 2021 by root via cibadmin on 10.0.81.31

2 nodes configured
1 resource configured

Online: [ 19.0.81.31 10.9.81.32 ]
Active resources:

vip4 (ocf::titan:telemetry-vip): Started 10.0.81.31

The previous image describes a cluster of two nodes, 10.0.81.31 and 10.0.81.32, which
both have the status of Online. The IPv4 VIP (vip4) is currently running on 10.0.81.31. The
IPv6 VIP (vip6) is not visible because it has not been configured.

If 10.0.81.31 failed, its status would look like this:

NN ] admin@titan-8HIP2JLB: ~

Stack: corosync

Current DC: 10.0.81.32 (version 2.0.1-9e9@9a5bdd) - partition with quorum
Last updated: Tue Jan 26 16:17:22 2021

Last change: Tue Jan 26 15:45:04 2021 by root via cibadmin on 10.0.81.31

2 nodes configured
1 resource configured

Online: [ 10.0.81.32 ]
OFFLINE: [ 10.0.81.31 ]

Active resources:

vip4 (ocf::titan:telemetry-vip): Started 10.0.81.32

Notice how 10.0.81.31 is now shown as OFFLINE and the vip4 has moved to 10.0.81.32.

View Current Cluster Configuration

To view the current configuration of the cluster to verify that the Corosync and Pacemaker
configuration is correct, complete the following steps:
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1. Login as the admin to any of the broker nodes in the cluster from the console into
the virtual machine provided by VMWare vCenter, or via SSH. Use the password
that was supplied during node installation.

2. Runthe sudo crm configure show command. This presents a view of the
currently configured attribute on the cluster. You can see more details about this
command here.

[ N admin@titan-8HIP2JLE: ~

admin@titan-8H1P2JLB:~% sudo crm configure show
node 1: 10.0.81.31
node 2: 10.0.81.32
primitive vip4 ocf:titan:telemetry-vip \
params ip=10.0.81.63 cidr_netmask=24 nic=et
op monitor interval=5s
property cib-bootstrap-options: \
have-watchdog
dc-version=2

no—quorum-policy=ignc
start-failure-is-fatal=false
rsc_defaults rsc-options: \
resource-stickiness=
alert ctb_manager pt/titan/con
to locall

admin@titan-8HLP2JLB:~$ [

Enable and Disable Node Standby Mode

In Standby mode, the node cannot host the IPv4 or IPv6 virtual IP addresses.

1. Login as the admin to any of the broker nodes in the cluster from the console into
the virtual machine provided by VMWare vCenter, or via SSH. Use the password
that was supplied during node installation.

2. Runthe sudo crm node standby 10.0.81.32 command. You can omit the
node name if you are running this command on that node. You can see more details
about this command here.

3. Runthe sudo crm node online 10.0.81.32 command to move the node out of
Standby status. You can see more details about the command here.
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[ N admin@titan-8HIP2JLB: ~
Stack: corosync
Current DC: 10.0.81.32 (version 2.0.1-9e909a5bdd) - partition with quorum
Last updated: Tue Jan 26 16:41:49 2021
Last change: Tue Jan 26 16:41:44 2021 by root via crm_attribute on 10.0.81.32

2 nodes configured
1 resource configured

Node 10.0.81.32: standby
Online: [ 10.0.81.31 ]

Active resources:

vipd (ocf::titan:telemetry-vip): Started 10.0.81.31

As you can see, crm_mon displays the standby status of the 10.0.81.32 node.

Move a VIP to a Specific Node

You may encounter circumstances in which you want to specify which node is running the
IPv4 or IPv6 virtual IP address. If so, complete the following steps:

1. Log in as the admin to any of the broker nodes in the cluster from the console into
the virtual machine provided by VMWare vCenter, or via SSH. Use the password
that was supplied during node installation.

2. Runthe sudo crm resource move vip4 10.0.81.32 command. You can see
more details about this command here.

3. Runthe sudo crm resource unmove vip4 command to make sure the VIP stays
on the targeted node, otherwise the VIP will move back to the node it was
previously on (before the move) at the next opportunity.
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Configure Your Virtual Machine to use a
Physical NIC

We have pre-configured the ctb-node OVA file with a Telemetry Network interface using
the vmxnet3 virtual driver. The vmxnet3 driver should work fine for workloads up to
approximately 1Gbps, but it will begin to lag for workloads that exceed approximately 1
Gbps.

To support full 10Gbps telemetry, you need to configure your VM to use a physical NIC,
which in VMWare is called VMDirectPath 1/O passthrough. The Configuring VMDirect I/O
pass-through knowledgebase article explains how to configure a physical NIC as a pass-
through device.

After you set up the ESXi server with a passthrough device, complete the following to add
it to the ctb-node VM:

1. After you import the OVA file, shut down the VM.
2. Inthe vSphere Client, right-click the virtual machine and click Edit Settings.

a. Click Add New Device.
b. Choose PCI Device.

Choose the pci pass-through device you configured.

Qa o

To update the VM memory settings, check the Reserve all guest memory
(All locked) check box.

e. Click OK.

3. Start the VM and run through the install process as described above. After you enter
your password you will be prompted to choose the Management Network
interface and Telemetry Network interface from a list of three different NICs.

a. Use the 82574L Gigabit Network Connection NIC as the Management
Network interface.

b. Use the pass-through NIC as the Telemetry Network interface (the
description will most likely say (70Gbps).

Your virtual machine is now running with a pass-through interface.
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Enable a Flow Generator Input on a Broker
Node (Optional)

Starting with v2.1.3, you can enable a Flow Generator input on a broker node.

Cisco Telemetry Broker has configured the OVA file with the following three options:
¢ 1 Gbps
e 10 Gbps

¢ Transformation-Capable

g::is’i’:l:ration CcPU Memory Storage
1 Gbps 3 12GB 70 GB
10 Gbps 9 16 GB 70 GB
Transformation 12 16 GB 70 GB

If the number of CPUs or memory does not comply with the requirements shown in the
previous table, the broker node will still work, but with degraded performance.

After you import the OVA file, you can add more CPUs, memory, and a network interface
to make the node capable of receiving raw network traffic from the monitoring interface
and to generate IPFIX records. This optional functionality is provided by the Flow
Generator Plugin on the broker node. The IPFIX records can then be forwarded by the
broker node from the Flow Generator input to configured destinations. If you wish to
enable Flow Generator functionality, depending on which hypervisor you are using,
complete the following steps in the applicable section.

0 The following instructions assume that the broker's telemetry interface has
already been configured as specified in Configure the Telemetry Interface.

1. Shut down the VM.
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0 It is mandatory that you shut down the VM, even if you just want to add a network
device.

2. Inthe vSphere Client, right-click the virtual machine and click Edit Settings.
3. Do one of the following:

e Add 1 CPU for a 1 Gbps deployment

* Add 4 CPUs for a 10 Gbps deployment or for a Transformation deployment
4. Do one of the following:

e Add 4G memory for a 1 Gbps deployment

» Add 8G memory for a 10 Gbps deployment or for a Transformation
deployment

5. Click Add Network Adapter and add the network device you will use as a Flow
Generator monitoring interface.

6. From the Adapter drop-down list, choose the virtual switch port group you want this
adapter to connect to.

7. From the Adapter Type drop-down list, choose VMXNET 3. For example, see the
following screenshot.

(1 Edit settings - esxibare-ctb-fs (ESXi 6.7 virtual machine)

» [ CcPU 8 P

iy ® -
LS 68359375 | GB v

4 SCS! Controller 0 LSI Logic Parallel

» #H Network Adapter 1 VM Network « [ Connect

» MM Network Adapter 2 VM Network + @ Connect

~ ME New Network Adapter Port Group - PCAP Replay

Status Connect at power on
Adapter Type DGR3
MAC Address

Automatic . | | 00:00:00:00:00:00

save || Cancel

&
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8.
9.

1.

Click Save.
Start the VM.

Shut down the VM.

0 It is mandatory that you shut down the VM, even if you just want to add a network

device.

In the Virtual Machine Manager, from the main menu, click View > Details.

3. From the left pane, click CPUs.

10.
11.

Do one of the following:

e Add 1 CPU for a 1 Gbps deployment

» Add 4 CPUs for a 10 Gbps deployment or for a Transformation deployment
Do one of the following:

e Add 4G memory for a 1 Gbps deployment

» Add 8G memory for a 10 Gbps deployment or for a Transformation
deployment

In the lower left corner, click Add Hardware.

From the left pane, click Network.

To choose the subnet you want to monitor, do the following:
* On the details tab, choose a network source from the Network drop-down list

» Choose the applicable option from the Portgroup drop-down list

From the Device model drop-down list, choose virtio.
Click Finish.
Start the VM.

After completing the previous hypervisor specific resource steps, you now need to do the
following:

» Configure the monitoring interface from which to ingest the raw network traffic.

» Assign the Flow Generator input to the broker node.
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To enable Flow Generator functionality on the broker node, both the monitoring
interface and Flow Generator input must be configured, and you should also

0 assign Flow Generator input to the broker node. The order of configuration
should not matter, but we suggest to start with configuring the monitoring
interface, as documented in the steps below.

1. Start the broker node virtual machine.

From the command line of the broker node, run sudo ctb-install --config.
Click Monitoring Interface.

Select an option:

Use your mouse to access and select any element.
If your terminal doesn't support the use of a mouse,
use the Tab key to move among elements, the Up Arrow and Down Arrow keys
to move among menu options, and the Enter key to click a button.

Options:

Hostname

Management Network
Telemetry Interface
Monitoring Interface
Password

4. Choose the network adapter you added in VMWare to add it to the virtual machine
interface and set the MTU.
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Use your mouse to access and select any element.
If your terminal doesn't support the use of a mouse,
use the Tab key to move among elements, the Up Arrow and Down Arrow keys
to move among menu options, and the Enter key to click a button.

Please select monitoring interface:

Enter MTU for the monitoring interface (580-9000):

5. Click OK.
6. Inthe Cisco Telemetry Broker Manager Web UlI, click the Broker Nodes tab.
7. Inthe list of broker nodes, click the applicable broker node.
8. Click the Monitoring Interface tab and verify that the monitoring interface you
configured in Step 3 is correct.
deds Telemetry B:Jker ) posw (MownE & oo . s :; I

esxibare-ctb-fs

General Status Average Received Average Sent

Active D o

9. Click the Inputs tab.
10. Click Add Input.
11. From the Select input type drop-down list, choose Flow Generator Input.

12. Click Next.
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€ 5 € @ ONoiSecur hips://10.0.86.48/nputs * D oD 0@

® Apple W iCud W Wikipeda [ Uinkean [ vahoo B YouTube M Gmal  BY Maps (3 Al Bookmarks

Add Input x

Select Input type
[m-n-mlq-n ] @Al

UDP Input

AWS VPC Flow log

Azure NSG Flow log

Flow Generator Input ~
Flow Generator ingut.

e =

13. Inthe Input Name field, enter the input name.

14. Adjust other Flow Generator input parameters if the default values don't fit your
deployment.

15. Click Add Input.

0 To see the parameter description, hover over the tooltip (the "i" icon) next to the

parameter name.

[ @)
(oo )
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16. From the Assigned Broker Node drop-down list, assign the input you configured in
the previous step to the appropriate broker node.

17. Click Assign Nodes.

€ 3 @ @ ©nNotSecus hups:[10.0.86.48/nputs # Do O 0O :

& Apple o iCloud W Wikipedia B Linkedin .Ynhoo € YouTube M Gmail P Maps [ An Bookmarks
Assignments X

1g-input-62055 [

Assigned Broker Node 0 [optional)

[ [elect one from the list ~ ]

| esxibare-ctb-fs |
ennare{

The Flow Generator microservice, provided by the vpp-fs container on the broker node,
should now be running.

18. Verify this with the sudo docker ps command issued in the broker node terminal.

"fopt/init.d/start.sh"

19. Connect the Flow Generator input to the previously configured destination. This can
be either a UDP destination (for example, Cisco SNA Flow Collector), or an XDR/
SCA cloud destination. Just like with other input types, you can forward Flow
Generator input traffic to multiple destinations. You can do this from the Data Flow
page by clicking the plus sign (+) on the right side of the configured Flow Generator
Input card and dragging it to the applicable Destination card.

20. Click Save.
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€ 5 € @ ONotSecure hip:/10.0.86.48/data-low * DD 0O
@ Apcle @ iCloud W Wikipedia [ Unkedn [ Yohoo B Youlibe M Gmal Y Maps [ Al Boskmarks

Connect to a Destination ~ ~
Input

fg-input-62055

Destination
Cancel [ save |
21. Repeat Step 16 for all configured destinations.
€ 5 C @ ©NotSecure hitps:)/10.0.86.48/cata-flow * D0 0O0:
@ Apple @ iCoud W Wikipesia [ Lnkeoin [ vahoo B YouTube M4 Gmail P Maps £ Ail Bodkmarks
'::Il‘s'é'cli' Telemetry Broker A Overview W DataFlow % Destinations  1b Inputs @ Broker Nodes %, Manager Node A sl
Data Flow
inputs 1 (o) (Y Destinations = (e ]
[l-losmeeeivedLul 2. V] IQ Search by Destination Name ]
Q fg-input-62055 wmve @ 5 . Q fenfve-esxivare sue @
LA Fiow Generator lnput | A Assigned to (1) oM
; Q sensorstaging.obsrvbl.com seke [
o

At this point, your broker node will generate the metadata in the form of IPFIX records.
These records contain information about the raw network traffic observed on the
monitoring interface. The broker node forwards the records to configured destinations
with or without transformation, depending on the destination type.
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Disable Flow Generator Functionality

1. Do one of the following:
» Unassign Flow Generator input from the broker node.
» From the Monitoring Interface submenu of the terminal interface, set the
monitoring interface to None.
2. Runsudo ctb-install --config.

From the Monitoring Interface submenu, use the Down Arrow key to select None.

4. Click OK.

Use your mouse to access and select any element.
If your terminal doesn't support the use of a mouse,
use the Tab key to move among elements, the Up Arrow and Down Arrow keys
to move among menu options, and the Enter key to click a button.

Please select monitoring interface:

Enter MTU for the monitoring interface (500-9000): bl
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Enable Your Telemetry Broker License

Cisco Smart Licensing is a flexible licensing model that provides you with an easier,
faster, and more consistent way to purchase and manage software across the Cisco
portfolio and across your organization. And it's secure — you control what users can
access. With Smart Licensing you get:

» Easy Activation: Smart Licensing establishes a pool of software licenses that can
be used across the entire organization—no more PAKS (Product Activation Keys).

« Unified Management: My Cisco Entitlements (MCE) provides a complete view into
all of your Cisco products and services in an easy-to-use portal, so you always
know what you have and what you are using.

» License Flexibility: Your software is not node-locked to your hardware, so you can
easily use and transfer licenses as needed.

To use Smart Licensing, you must first set up a Smart Account on Cisco Software Central
(software.cisco.com). For a more detailed overview about Cisco Licensing, go to
cisco.com/go/licensingguide.

Assistance

For assistance with your Cisco Smart Account and Smart Licensing, please contact us
through either of the following resources:

» Go to Support Case Manager at https://mycase.cloudapps.cisco.com/case and
choose Software Licensing > Security Related Licensing as a case type.

e Call your TAC world-wide support number at

https://www.cisco.com/c/en/us/support/web/tsd-cisco-worldwide-contacts.html
and open a licensing request.

Licensing Overview
After you deploy the Manager, perform the following actions:

Create the initial super user account.

Create a Cisco Smart Account.

Open Smart Licensing in Telemetry Broker.

Review Evaluation Mode Status.

A e

Register Your Product Instance.
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If your Cisco Telemetry Broker does not have direct access to your Cisco Smart Account
and will communicate through a Smart Software Manager On-Prem (also known as
Transport Gateway), select Transport Gateway for your Transport Settings.

‘ 0 Cisco Telemetry Broker requires Smart Software Manager On-Prem v8-202010
or higher.

Review the following On-Prem guide to complete the installation and configuration.
e Smart Software On-Prem:

https://www.cisco.com/c/en/us/support/cloud-systems-management/smart-
software-manager-satellite/tsd-products-support-series-home.htmi

When you use Cisco Telemetry Broker in Evaluation mode, you can use it for 90 days.
Evaluation mode is based on active usage of Cisco Telemetry Broker. For example, if you
shut down Cisco Telemetry Broker, the countdown resumes when it is turned on again.

To use Cisco Telemetry Broker with maximum default functionality, and to add licenses
and features to your account, register your product instance with your Smart Software
Manager in Smart Licensing.

Make sure you register your product instance before the 90-day evaluation
period expires. When the evaluation period expires, Cisco Telemetry Broker
stops receiving telemetry from inputs and sending telemetry to destinations. To
resume functionality, register your product instance.

1. Inaweb browser, enter the Manager's management interface IP address and press
Enter to navigate to the Manager's web interface login.

2. Enter your first and last names, email address, user name (we suggest assigning the
user name of webadmin so as not to confuse it with the admin user), and
password, and click Create to create the initial super user account.

With a Cisco Smart Account, you can view your software, services, and devices in one
portal (also known as Cisco Smart Software Manager).

To use Smart Licensing with Cisco Telemetry Broker, you must have a Cisco Smart
Account. With a Cisco Smart Account, you can view your software, services, and devices
in one portal (also known as Cisco Smart Software Manager).
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For licensing Cisco Telemetry Broker, you will use your Smart Account to register your
product instance, manage licenses, run reports, and configure notifications. For more
information, refer to Smart Licensing on cisco.com.

» Tutorials: For video tutorials, refer to Smart Licensing Resources.

 Instructions: For detailed instructions about using your Cisco Smart Account, log in
to your Cisco Smart Account. Click Help or use the online assistant.

1. Loginto Cisco Telemetry Broker.

2. Click the 3¢ (Global Settings) icon in the toolbar in the upper right corner of any
page and choose Settings.

3. Click the Smart Licensing tab.

1. Open Smart Licensing in Cisco Telemetry Broker.

2. Click the Global Settings icon in the toolbar in the upper right corner of any page
and choose Settings.

3. Click the Smart Licensing tab.

4. Inthe Smart Software Licensing Status section, review Registration Status and
License Authorization Status.

Status Details

Your product instance is not
registered to a Cisco Smart
Account. Register your product
instance before the evaluation
period expires.

When the evaluation period
expires, Cisco Telemetry Broker
stops receiving telemetry from
inputs and sending telemetry to
destinations. To resume
functionality, register your product
instance.

Registration Status Unregistered
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After you have launched a Cisco

Telemetry Broker deployment and it
No Licenses in has started processing telemetry, it
Use takes 24 hours for Cisco Telemetry

Broker to calculate and report

License Authorization Status entitlement usage.

Your product instance is using
Evaluation mode and the number of

Evaluation Mode days remaining is shown. To see
more detailed information, hover
your pointer over the status.

To use Smart Licensing with Cisco Telemetry Broker, you must have a Cisco Smart
Account. With a Cisco Smart Account, you can view your software, services, and devices
in one portal (also known as Cisco Smart Software Manager).

For licensing Cisco Telemetry Broker, you will use your Smart Account to register your
product instance, manage licenses, run reports, and configure notifications. For more
information, refer to Smart Licensing on cisco.com.

» Tutorials: For video tutorials, refer to Smart Licensing Resources.

 Instructions: For detailed instructions about using your Cisco Smart Account, log in
to your Cisco Smart Account. Click Help or use the online assistant.

Use the following instructions in the order of the following steps to register your product
instance before the evaluation period expires.

Log in to your Cisco Smart Software Manager.

a.
b. Configure transport settings.

o

Create the registration token.

o

Register in Telemetry Broker.

e. (As Needed) Change product instance registration.

Make sure you register your product instance before the 90-day evaluation
period expires. When the evaluation period expires, Cisco Telemetry Broker
stops receiving telemetry from inputs and sending telemetry to destinations. To
resume functionality, register your product instance.
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a. Log into Your Cisco Smart Software Manager

To use Cisco Telemetry Broker with maximum default functionality, and to access
purchased licenses and features on your account, log in to your Cisco Smart Account and
register your product instance with your Smart Software Manager in Smart Licensing.

1. Go to Cisco Software Central at https://software.cisco.com.

2. Click the & (User) icon.

3. Log in with your CCOID credentials.

* Log In: If you have an account, click Log In.

* Create an Account: If you do not have an account, click Create an Account.
Follow the on-screen prompts to set up your account.

4. Inthe License section, choose Smart Software Licensing.

b. Configure Transport Settings

Configure how Cisco Telemetry Broker communicates with your Cisco Smart Account
(Cisco Smart Software Manager). If you change the configuration here, those changes will
apply to Smart Call Home and other features using this service.

Log in to Cisco Telemetry Broker.

Click the Smart Licensing tab.

In the Smart Software Licensing Status section, locate Transport Settings.

Click View/Edit.

BN~

If the product instance is already registered, deregister it before you change the
transport settings. Refer to Deregister for details.

5. Select a transport setting.

Transport Settings Description

Use this option if your Cisco Telemetry Broker has
direct access to your Cisco Smart Account and it is

Direct not blocked by a firewall. Cisco Telemetry Broker
lists the URL that Cisco Telemetry Broker will
attempt to directly access.
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If Cisco Telemetry Broker does not have direct
access to your Cisco Smart Account and will
communicate through Transport Gateway or Smart
Software Manager On-Prem, choose Transport

Gateway.

T
ransport Gateway In the URL field, enter the location of the Smart

Software Manager On-Prem that contains the
licenses for your product instance.

For Example:
https://<SSM-ON-PREM-URL>SmartTransport

This option is available only if you've configured
Cisco Telemetry Broker to use a proxy. If so, you
can choose the HTTPS Proxy option to tell Cisco
Telemetry Broker to use the proxy for
communicating with the Cisco Smart Licensing
server. To configure the proxy, refer to the next
section, c. Configure the Internet Proxy, for
instructions.

HTTPS Proxy

6. Select Save.

c. Configure the Internet Proxy
To enable the HTTPS Proxy option for your Cisco Telemetry Broker Transport Settings,

make sure your Internet Proxy is configured.
1. Loginto Cisco Telemetry Broker.
2. Click the Global Settings icon in the toolbar in the upper right corner of any page.

3. Click the Use HTTPS proxy Toggle icon to enable HTTPS proxy functionality (the
icon bar will turn blue).

4. Inthe IP Address field, enter the proxy server IP address.

5. Inthe Port field, enter the port number Cisco Telemetry Broker uses to
communicate with the proxy server.

6. Click Save.
d. Create the Registration Token

1. Loginto your Cisco Smart Account at https://software.cisco.com.

2. Inthe License section, choose Smart Software Licensing.
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3. Select Inventory.
4. Inthe Product Instance Registration Tokens section, click New Token.

5. Complete the fields in the Create Registration Token dialog box to identify the token
on your account and specify how it can be used.

6. Click Create Token.
7. Locate your token in the Product Instance Registration Tokens list.

8. Copy the Token: Click the token name and copy it, or choose one of the following:

» Copy: To copy the token, click Actions > Copy

 Download: To download the token as a text file, click Actions > Download.

e. Register in Cisco Telemetry Broker

1. Open Smart Licensing in Cisco Telemetry Broker.
2. Click Register.

3. Paste the token as plain text or type it into the Product Instance Registration Token
window.

4. Click Register.

o If the communication times out during registration, review your transport
settings.

5. Review the Smart Software Licensing Status section and confirm:

* Registration Status: Registered
¢ License Authorization Status: Authorized

» Out of Compliance: If the status is shown as Out of Compliance, you may
need to add licenses to your account. Refer to Troubleshoot Licensing for
more information.

6. Review the Smart License Usage section. Confirm all licenses are shown as
Authorized.

o Status Details: Open Smart Licensing in Cisco Telemetry Broker and review
Smart License usage to determine which licenses are out of compliance.

» Out of Compliance: If any licenses are shown as Out of Compliance, you may
need to add licenses to your account. Refer to Troubleshoot Licensing for
more information.
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f. (As Needed) Change Product Instance Registration

Use the following instructions to change or update your product instance registration with
your Smart Software Manager in Smart Licensing.

Deregister

Use the following instructions to remove your product instance from your Cisco Smart
Account. If you deregister your product instance, note the following:

 Virtual Account Inventory: The licenses it was using are returned to the virtual
account, and other product instances in your account can use those licenses.

¢ Evaluation Mode: Your product instance will return to Evaluation mode if there are
days remaining in your evaluation period.

Use deregister before you change your transport settings or for troubleshooting.

1. Open Smart Licensing in Cisco Telemetry Broker.
2. Click Actions.
3. Select Deregister.

Reregister

If your product instance was disconnected or Cisco Telemetry Broker could not connect
with the Cisco Smart Account after repeated attempts, the License Authorization Status

shows Registration Expired. Use the following instructions to resolve any communication
issues and reregister the product instance.

1. Open Smart Licensing in Cisco Telemetry Broker.

2. Check your Transport Settings and review your Cisco Smart Account to confirm
communications.

A If you need to change your transport settings, deregister your product instance
first.

Click Actions > Reregister.

Log in to your Cisco Smart Account at https://software.cisco.com.

In the License section, choose Smart Software Licensing.
Select Inventory.

N o o~ o

In the Product Instance Registration Tokens section, click New Token, or locate
your token in the Product Instance Registration Tokens list.
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8. Copy the token and paste it into the Product Instance Registration Token window in

Cisco Telemetry Broker.

9. Click Reregister.

10. Review your Smart Software Licensing Status to confirm:

* Registration Status: Registered

¢ License Authorization Status: Authorized

When you register your product instance with your Smart Software Manager in Smart
Licensing, the Cisco Telemetry Broker Smart Licensing page shows your Cisco Smart
Account and product instance details, including the following:

Product Instance Details

Information
Registration Status

License Authorization Status

Export Control Functionality

Smart Account

Virtual Account

Product Instance Name

Transport Settings

Details
Refer to Registration Status for details.
Refer to License Authorization Status for details.

Refer to the online help in your Cisco Smart
Account.

Refer to the online help in your Cisco Smart
Account.

Refer to the online help in your Cisco Smart
Account.

The Product Instance Name is the identifier we use
for your Cisco Telemetry Broker product instance,
which includes your Cisco Telemetry Broker
Manager Node and broker nodes. Use your product
instance name to identify your product instance in
your Cisco Smart Account.

Refer to Step 2 in the "Register Your Product
Instance' section in Enable Your Telemetry
Broker License for details.
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Registration Status

Cisco Telemetry Broker connects to your Cisco Smart Account and reports the licensing
status and usage.
1. Open Smart Licensing in Telemetry Broker.

2. Review the Smart Software Licensing Status section.

Status Details

Your product instance is registered and reporting
license usage to your Cisco Smart Account. To see
renewal and expiration details, hover your pointer
over the status.

Registered

Your product instance is not registered to a Cisco
Smart Account. Register your product instance

before the evaluation period expires.
Unregistered

Refer to "Evaluation Mode (90 Days)" and "Register
your Product Instance" in Enable Your Telemetry
Broker License for details.
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License Authorization Status

Status

Authorization Expired

Authorized

Evaluation Period Expired

Evaluation Mode

Out of Compliance

Details

If Cisco Telemetry Broker loses communication
with your Cisco Smart Account, your authorization
may expire.

Authorization Expired indicates the communication
status. It is does not indicate license status. To
review license status (purchased, expired, and
usage), review your Cisco Smart Account.

Your product instance is registered and your
licenses are authorized.

To see authorization attempts and details, hover
your pointer over the status.

Your evaluation period has expired and telemetry
processing has stopped. To see more detailed
information, hover your pointer over the status.

Refer to "Evaluation Mode (90 Days)" and "Register
your Product Instance" in Enable Your Telemetry
Broker License for details.

Your product instance is using Evaluation mode and
the number of days remaining is shown. To see
more detailed information, hover your pointer over
the status.

Refer to "Evaluation Mode (90 Days)" and "Register
your Product Instance" in Enable Your Telemetry
Broker Licensefor details.

If there is a license shortage for Cisco Telemetry
Broker, it is out of compliance.

Refer to "Resolve Out of Compliance"
inTroubleshoot Licensing for details.
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Review Smart License Usage
Cisco Telemetry Broker reports license usage to your Cisco Smart Account.

If your Smart License status shows Out of Compliance, this indicates that Cisco Telemetry
Broker has a license shortage and is using more licenses than are allocated in your Cisco
Smart Account. Refer to the "Resolve out of Compliance" section in Troubleshoot
Licensing

Use the following instructions to resolve any license-related errors shown in Smart
Licensing.

Resolve Out of Compliance

If the License Authorization Status or Smart License Usage shows Out of Compliance, an
appliance or feature has a license shortage and is using more licenses than are allocated
in your Cisco Smart Account.

Review your Licenses
Review the following:
» Open Smart Licensing in Cisco Telemetry Broker and review Smart License usage
to determine which licenses are out of compliance.

» Confirm you have sufficient licenses assigned to your virtual account. Refer to your
Cisco Smart Account for details.

 |If you need to purchase additional licenses, please contact your account Manager
or the Cisco Telemetry Broker Sales team at stealthwatch-sales@cisco.com.

Update Cisco Telemetry Broker

After you add or move licenses to your virtual account, use the following instructions to
update the status in Telemetry Broker.

Renew Authorization Now

Cisco Telemetry Broker reports license usage to your Cisco Smart Account. Use Renew
Authorization Now to connect to your account and update your license usage telemetry
immediately. Use these instructions if you've changed the licenses on your Cisco Smart
Account, but they are not shown on your Smart Licensing page.

1. Open Smart Licensing in Cisco Telemetry Broker.
2. Click Actions > Renew Authorization Now.
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Renew Registration Now

If your product instance was disconnected or Cisco Telemetry Broker could not connect
with the Cisco Smart Account after repeated attempts, the License Authorization Status
shows Registration Expired. Use Renew Registration Now to connect to your account
and update your registration status.

1. Select the Actions menu.

2. Select Renew Registration Now.

Registration Expired: If the License Authorization Status continues to show
Registration Expired, you may need to reregister the product instance. Refer to
"Reregister" in Enable Your Telemetry Broker License for details.
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Review License Expiration Status

Your purchased licenses, allocations, expiration status, and usage are shown in your
Cisco Smart Account. For more information, refer to "Cisco Smart Account" in Enable

Your Telemetry Broker License.
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Troubleshoot Cisco Telemetry Broker

General: Since the appliance is running a stock Debian 10 operating system, you can
apply most general Linux system administration practices to troubleshooting.

Management Networking: The Management Network interface on the appliance is
managed through the systemd-networkd service rather than the ifup, ifdown or ifconfig
tools that you may be familiar with. After you have completed the installation of Cisco
Telemetry Broker, you can find configuration information in this file:

/etc/systemd/network/management.network

Telemetry Networking: The Manager Node manages the Telemetry Network interface on
the appliance. After installation, the Telemetry Network interface is mostly invisible to the
operating system. Therefore, you must make configurations using the Cisco Telemetry
Broker management layer.

Telemetry Packet Capture: Just as with configuration, you use a custom Cisco
Telemetry Broker tool to capture packets on the Telemetry Network interface instead of
operation system utilities. To do this, you must SSH to the appliance and run the following
command:

$ sudo ctb-pcap -V -n 1000 -t 15 -s 10.203.3.3 -o test tx src.pcap
rx

This command writes the captured output to /var/lib/titan/pcap/test_tx_src.pcap. You
can use the —help option to view all the available options.

Diagnostics: The appliance contains a diagnostic tool named Mayday that can capture
debug information for the Cisco Telemetry Broker engineering team. You should include
this helpful information to bug reports.

To create a diagnostic pack with Mayday, simply SSH to the appliance and run the
following command:

sudo mayday

This will compile the relevant system information into a tar ball that can be copied off the

node to another location using the SCP tool. The location of the resulting tar ball will be
included in the Mayday logs.
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Example:

$ ssh admin@<ctb-node-ip>
ctb-node> sudo mayday
<output-redacted>

2020/08/05 19:04:45 Output saved in /tmp/mayday-ctb-5SWVTpSx-—
202008051904.677025165.tar.gz

2020/08/05 19:04:45 All done!
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Finish Configuring Your System

To finish configuring your system, refer to the following sections in the Cisco Telemetry
Broker User Guide:

¢ Destinations
* Inputs

* Broker Nodes
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Appendix A: Using Adaptive Mode on a Broker
Node

By default, the Telemetry Network interface on the broker node is configured to operate in
Polling mode (where the system continuously polls for network traffic). This increases
CPU utilization even when there is low network traffic, but it provides high performance
under heavy network traffic.

In CTB v1.4 and later, you can place the Telemetry Network interface in Adaptive mode. In
this mode, at low bandwidth rates, the interface processes data as it becomes available;
it does not poll for data. At higher bandwidth rates the interface switches to Polling mode.
This reduces CPU utilization under low network loads.

We recommend that you use Adaptive mode ONLY if the broker node expects
0 non-bursty, low bandwidth UDP traffic (< 500K PPS). If this is not the case, then
do not enable Adaptive mode, as it could result in dropped packets.

In order to use Adaptive mode for a broker node, you need to manually enable IOMMU on
your broker node’s VM after you have completed the upgrade to v1.4. Enabling IOMMU
automatically puts the Telemetry Network interface in Adaptive mode.

For more information, see the "Software Update" chapter in the Cisco Telemetry Broker
User Guide.

This first step is common to both VMWare and KVM, so complete this step before you
progress to the appropriate section.

* Log in to the broker node shell and add this command:

set interface rx-mode ethl adaptive
to this file:
/var/lib/titan/vppconfig/vpp custom cmds.txt
VMWare

IOMMU is supported on ESXi v6.7+. If you have ESXi v6.7+, complete the following steps
to upgrade VM compatibility and enable IOMMU.

You need to complete Step 1 through Step 5 only if you have upgraded from a
previous version to v1.4 (or any future released versions).
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1. Loginto the VMWare vSphere web user interface.

2. Shut down the VM for the broker node.

3. From the main menu, choose Actions > Upgrade VM Compatibility.

= titan-node-1

o | b Poweron

titan-node-1
Guest 05
Compatibility
VMware Tools
cPUs

Memary

| # Edit | @ Reiresh

(& titan-node-1

Debian GNU/Linux 10 (540 (f Power

ESXI 6.5 virtual machine
Yes

2

4GB

@ Guest 08
G Snapshots
& Console

iy Autostart

~ General Information
» @ Networking

+ &8 Vhware Tools Vilware Tools is not managed by vSphere
» £ storage 1 disk

(=) Notes

@ Export With Images
& Editsattings

&, Permissions

[ Editnotes

] Rename

{5 Unregister

{5 Delste

@ Heb

{5 Openin a new window

I
| EAdmna I

& Upgrade VM Compatibiity
@ Export Upgrade Virtual Machine Compatibility

cPu

0 MHz D

MEMORY
0B

sTomsce

4.93 GB

ware Configuration
pu

emory

rd disk 1

Btwork adapter 1
Btwork adapter 2

2VCPUs

4GB

62.36 GB

VM Network (Connected)
VM Network (Connected)

nsumed host CPU

MK Consumed host memery
R Active guest memory
~ E storage
Provisioned

Uncommitted

Not-shared

fdeo card 4MB

JDVD drive 1 Remote davice CD/DVD drive 0
hers Additional Hardware

urce Consumption

0MHz
omB
omB

68.36 GB
67.62 GB
403GE

4. Inthe Configure VM Compatibility dialog, choose ESXi 6.7 virtual machine from the

drop-down list, and then click Upgrade.

(% Configure VM Compatibility

Select a compatibility for titan-node-1 upgrade.

[ ESXi 6.7 virtual machine

| Upgrade || Cancel |

P
=l

5. Inthe Confirm VM Compatibility Upgrade dialog, click Yes.

1. Confirm VM Compatibility Upgrade

This operation changes the compatibility of your virtual machine. It
is an irreversible operation that makes your virtual machine
incompatible with earlier versions of VMware software products.

Make a backup copy of your virtual machine files before proceeding.

Upgrade your compatibility?

L) |
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6. After the upgrade process has finished, to edit the VM's settings, click Edit from the
main menu.

(] titan-node-1

Console oniter | b Power on Power off Suspend Restart |IfEdit |IeF€efresh | £ Actions

titan-node-1 | Edit this virtual machine's settings |
Guest 05 Debian GHMU/Linux 10 (64-bif)

Compatibility ESXi 6.7 virtual machine

VMware Tools Ves

CPUs 2

Memory 4 GB

7. Inthe Edit settings dialog, complete the following steps:
a. Inthe left panel, click the arrow for the CPU option.
b. Check the Expose IOMMU to the guest OS check box.

c. Click Save.

(%) Edit settings - titan-node-1 (E SXi 6.7 virtual machine)

Virtual Hardware | VM Options |

28 Add hard disk Bl Add network adapter [ Add other device
Ce : -|o

Cores per Socket

1 - Sockets:2
CPU Hot Plug CJEnable CPU Hot Add

Reservation None

ot Unlimited

Shares Normal

Hardware virtualization

[ Expose hardware assisted virtualizaton fo the guest 0S ()

1OMMU 1 Expose IOMMU to the guest 0S

8. Verify that
» your VM's compatibility type is ESXi 6.7 virtual machine.
» the IOMMU option status is set to Enabled.
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~ Resource Consumption
& consumed host CPU
i Consumed host memery

K Active guest memory

0MHz

omB
omB

9. Power on the VM.

10. Run the following command to check the mode:
docker exec -it titan-vpp vppctl show hardware ethl
11. Verify that all vop_wk_x threads are in adaptive mode instead of polling mode.
Example:
Name Tdx Link Hardware
ethl 1 up ethl
Link speed: 1@ Gbps
RX Queues:
queue thread mode
2} vpp_wk_8 (1) adaptive
1 vpp_wk_1 (2) adaptive
2 vpp_uwk_2 (3) adaptive
3 vpp_wk_3 (4) adaptive
KVM

To enable Adaptive mode in KVM, make the following configuration changes for the XML

domain using the Virtual Machine Manager user interface.

1. Open the Virtual Machine Manager on your Linux sytem that is running KVM.

2. Open the Broker Node virtual machine and click the @ (Information) icon to see the

virtual hardware details.
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3. Click the XML tab.

4. Inthe left panel, click Overview. Confirm IOAPIC is enabled.

CTB Broker Node - Deployment Test on QEMU/KVM: titan-kvm-temp0

File VirtualMachine View Send Key

= 0 mo- @
Detalls XML

D OS information

<domain type="kvm">

@8 Performance <name>titan-node</name>
C} CPUs <uuid>5edf463d-f210-4543-8114-0e51493cc36f</uuid>
<title>CTB Broker Node - 1J/title
&5 Memory <metadata>
.15 Boot Options <libosinfo:libosinfo xmlns:libosinfo="http://libosinfo.org/xmlns
. <libosinfo:os id="http://debian.org/debian/9"/>
@ SCSIDisk 1 </libosinfo:libosinfo>
Jf' NIC:bc:a0:2f </metadata>
"\ﬁ NIC :86:85:08 <memory unit="KiB">2097152</memory>
<currentMemory unit="KiB">2097152</currentMemory>
@] Tablet <vcpu placement="static">5</vcpu>
Mouse <resource>
- <partition>/machine</partition>
(=) Keyboard </resource>
[_:_] Display VNC <0s> .
) <type arch="x86 64" machine="pc-q35-5.2">hvm</type>
sound ich9 <boot dev="hd"/>
G Serial1 </0s>
2 channel gemu-ga <features>
<acpi/>
s Channel spice <apic/>
Q Video QXL <vmport state="off"/>
<ioapic driver="gemu"/>
m Controller USB 0 </features>
m Controller SATA 0 <cpu mode="custom" match="exact" check="full">
—a <model fallback="forbid">Broadwell-IBRS</model>

Add Hardware Cancel Apply

5. Add the IOMMU device.
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CTB Broker Node - Deployment Test on QEMU/KVM: titan-kvm-temp0 - 0 @

File VirtualMachine View SendKey

- @ o

Q OS information
B8 rerformance
{3 crus

% Memory

;;v, Boot Options
(@) scsipisk 1

J} NIC :bc:a0:2f
b Nic:s6:8s:08
@] Tablet

) Mouse

[=] Keyboard

Q Display VNC
Sound ichg

2 serial1

¢ Channel gemu-ga
¢ Channel spice
C] Video QXL

m Controller USBO
B controller saTa0

Add Hardware

N

Details XML

<address type="pci” domain="0x0000" bus="0x00" slot="0x1b" fun
</sound>
<video>
<model type="gxl" ram="65536" vram="65536" vgamem="16384" head
<address type="pci" domain="0x0000" bus="0x00" slot="0x01" fun
</video>
<redirdev bus="usb" type="spicevmc">
<address type="usb" bus="0" port="2"/>
</redirdev>
<redirdev bus="usb" type="spicevmc">
<address type="usb" bus="0" port="3"/>
</redirdev>
<memballoon model="virtio">
<stats period="5"/>
<address type="pci" domain="0x0000" bus="0x05" slot="0x00" fun
</memballoon>
<rng model="virtio">
<backend model="random">/dev/urandom</backend>
<address type="pci" domalh:”@xOﬂ@O” bus="0x06" slot="0x00" fun
</rng>
<iommu model="intel">
<driver intremap="on" caching mode="on"/>
</iommu>
</devices>
<seclabel type="dynamic" model="dac" relabel="yes"/>
</domain>

Cancel Apply

6. Inthe left panel, click the NIC device that will be used as the Telemetry Network

interface. Confirm it has IOMMU and ATS enabled. We recommend that you

configure a queue size of 5.
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CTB Broker Node - Deployment Test on QEMU/KVM: titan-kvm-temp0

File VirtualMachine View Send Key

= @ o~ - s

function=

Q Overview Detalls XML
D OS information
e <interface type="bridge">
@8 erformance <mac address="52:54:00:86:85:08"/>
C} CPUs <source bridge="ovsbre"/>
<vlan>
&5 Memory <tag id="81"/>
£; Boot Options </vlan>
@ SCSI Disk 1 <virtualport type="jswitch">
= <parameters interfaceid="f61618f2-507a-4378-alal-481e7b73975c"/>
J} NIC:bc:a0:2f </virtualport>
Jf' NIC :86:85:08 <target dev="vnet3857"/>
4 <model tvpe="virtio"/>
ZIJ Tablet |<dr1ver queues="5" iommu="on" ats="on"/> |
Mouse <alias name="netl"/>
- <address type="pci" domain="0x0000" bus="6x02" slot="0x00"
(=] Keyboard </interface>
O Display VNC
Sound ich9
G Serial1

5 Channel gemu-ga
G Channelspice
() video QxL

m Controller UsB 0
B controller saTA0

Add Hardware Remove Cancel

Apply

7. Run the following command to check the mode:

docker exec -it titan-vpp vppctl show hardware ethl

8. Verify that all vop_wk_x threads are in adaptive mode instead of polling mode.

Example:
HName Tdx Link Hardware
ethl 1 up ethl
Link speed: 19 Gbps
R¥ Queues:
queue thread mode
2} vpp_wk_8 (1) adaptive
1 vpp_wk_1 (2) adaptive
2 vpp_wk_2 (3) adaptive
3 vpp_wk_3 (4) adaptive
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Contact Support

If you need technical support, please do one of the following:

Contact your local Cisco Telemetry Broker Partner
Contact Cisco Telemetry Broker Support

To open a case by web: http://www.cisco.com/c/en/us/support/index.html

To open a case by email: tac@cisco.com
For phone support: 1-800-553-2447 (U.S.)

For worldwide support numbers:
https://www.cisco.com/c/en/us/support/web/tsd-cisco-worldwide-contacts.html
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Copyright Information

THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS
MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS,
INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE
ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY
PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING
PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE
PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE
TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO
REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program
developed by the University of California, Berkeley (UCB) as part of UCB's public domain
version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of
the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND
SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS" WITH ALL FAULTS. CISCO
AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR
IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE
OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL,
CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION,
LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR
INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not
intended to be actual addresses and phone numbers. Any examples, command display
output, network topology diagrams, and other figures included in the document are
shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in
illustrative content is unintentional and coincidental.

All printed copies and duplicate soft copies of this document are considered
uncontrolled. See the current online version for the latest version.
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Cisco has more than 200 offices worldwide. Addresses and phone numbers are listed on
the Cisco website at https://www.cisco.com/c/en/us/support/web/tsd-cisco-
worldwide-contacts.html.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its
affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this
URL: https://www.cisco.com/go/trademarks. Third-party trademarks mentioned are the
property of their respective owners. The use of the word partner does not imply a
partnership relationship between Cisco and any other company. (1721R)
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